Unit 1l

Introduction to Android
Syllabus: The Android 4.1 jelly Bean SDK, Understanding the Android Software Stack, installing the Android
SDK, Creating Android Virtual Devices, Creating the First Android Project, Using the Text view Control,
Using the Android Emulator, The Android Debug Bridge(ADB), Launching Android Applications on a
Handset.

INTRODUCTION

Android is a mobile operating system developed by Google, based on a modified version of the Linux
kernel and other open source software and designed primarily for touchscreen mobile devices such as
smartphones and tablets. In addition, Google has further developed Android TV for televisions, Android Auto
for cars, and Wear OS for wrist watches, each with a specialized user interface. Variants of Android are also
used on game consoles, digital cameras, PCs and other electronics.

The Android Operating System is a Linux-based OS developed by the Open Handset Alliance (OHA).
The Android OS was originally created by Android, Inc., which was bought by Google in 2005. Google teamed
up with other companies to form the Open Handset Alliance (OHA), which has become responsible for the
continued development of the Android OS.

The android is a powerful operating system and it supports large number of applications in Smartphones.
These applications are more comfortable and advanced for the users. The hardware that supports android
software is based on ARM architecture platform. The android is an open source operating system means that it’s
free and any one can use it. The android has got millions of apps available that can help you managing your life
one or other way and it is available low cost in market at that reasons android is very popular.

Each time the OHA releases an Android version, it names the release after a dessert. Android 1.5 is known as
Cupcake, 1.6 as Donut, 2.0/2.1 as Eclair, 2.2 as Froyo and 2.3 is dubbed Gingerbread. Once a version is
released, so is its source code.

The Android OS is designed for phones. The important features of android are given below:

1) It is open-source.

2) Anyone can customize the Android Platform.

3) There are a lot of mobile applications that can be chosen by the consumer.

4) It provides many interesting features like weather details, opening screen, live RSS (Really Simple
Syndication) feeds etc.

It provides support for messaging services(SMS and MMS), web browser, storage (SQL.ite), connectivity
(GSM, CDMA, Blue Tooth, Wi-Fi etc.), media, handset layout etc.

Software developers who want to create applications for the Android OS can download the Android Software
Development Kit (SDK) for a specific version. The SDK includes a debugger, libraries, an emulator, some
documentation, sample code and tutorials. For faster development, interested parties can use graphical
integrated development environments (IDEs) such as Eclipse to write applications in Java.

Android Emulator:

The Emulator is a new application in android operating system. The emulator is a new prototype that is used to
develop and test android applications without using any physical device.
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The android emulator has all of the hardware and software features like mobile device except phone calls. It
provides a variety of navigation and control keys. It also provides a screen to display your application. The
emulators utilize the android virtual device configurations. Once your application is running on it, it can use
services of the android platform to help other applications, access the network, play audio, video, store and

retrieve the data.

Android versions

Google did not attach any high-calorie code name to its initial versions 1.0 and 1.1 of the Android Operating
System. The code names of android ranges from A to N currently, such as Aestro, Blender, Cupcake, Donut,
Eclair, Froyo, Gingerbread, Honeycomb, Ice Cream Sandwitch, Jelly Bean, KitKat, Lollipop and Marshmallow.

Let's understand the android history in a sequence.
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THE ANDROID 4.1 JELLY BEAN SDK

The Android 4.1 Jelly Bean SDK was released with new features for developers in July 2012. It improves the
beauty and simplicity of Android 4.0 and is a major platform release that adds a variety of new features for
users and app developers. A few of the big features of this release include the following:

* Project Butter—Makes the Jelly Bean Ul faster and more responsive. Also CPU Touch Responsiveness is
added, which increases CPU performance whenever the screen is touched. It uses the finger’s speed and
direction to predict where it will be located after some milliseconds, hence making the navigation faster.

» Faster speech recognition—Speech recognition is now faster and doesn’t require any network to convert
voice into text. That is, users can dictate to the device without an Internet connection.

« Improved notification system— The notifications include pictures and lists along with text. Notifications can
be expanded or collapsed through a variety of gestures, and users can block notifications if desired. The
notifications also include action buttons that enable users to call directly from the notification menu rather
replying to email.

« Supports new languages—Jelly Bean includes support for several languages including Arabic, Hebrew,
Hindi, and Thai. It also supports bidirectional text.

* Predictive keyboard—On the basis of the current context, the next word of the message is automatically
predicted.

« Auto-arranging Home screen—Icons and widgets automatically resize and realign as per the existing space.

* Helpful for visually impaired users—The Gesture Mode combined with voice helps visually impaired users
to easily navigate the user interface.

« Improved Camera app—The Jelly Bean Camera app includes a new review mode of the captured photos.
Users can swipe in from the right of the screen to quickly view the captured photos. Also, users can pinch to
switch to a new film strip view, where they can swipe to delete photos.

* Better communication in Jelly Bean—Two devices can communicate with Near Field Communication
(NFC); that is, two NFC-enabled Android devices can be tapped to share data. Also, Android devices can be
paired to Bluetooth devices that support the Simple Secure Pairing standard by just tapping them together.

» Improved Google Voice search—Jelly Bean is equipped with a question and answer search method that
helps in solving users’ queries similar to Apple’s popular Siri.

« Face Unlock—Unlocks the device when the user looks at it. It also prevents the screen from blacking out.
Optionally “blink™ can be used to confirm that a live person is unlocking the device instead of a photo.

» Google Now—Provides users “just the right information at just the right time.” It displays cards to show
desired information automatically. For example, the Places card displays nearby restaurants and shops while
moving; the Transit card displays information on the next train or bus when the user is near a bus stop or
railway station; the Sports card displays live scores or upcoming game events; the Weather card displays the
weather conditions at a user’s current location, and so on.

» Google Play Widgets—Provides quick and easy access to movies, games, magazines, and other media on the
device. It also suggests new purchases on Google Play.

« Faster Google Search—Google Search can be opened quickly, from the lock screen and from the system bar
by swiping up and also by tapping a hardware search key if it is available on the device.

* Supports antipiracy—This feature supports developers in the sense that the applications are encrypted with a
device-specific key making it difficult to copy and upload them to the Internet.



UNDERSTANDING THE ANDROID SOFTWARE STACK

The Android operating system is built on top of a modified Linux kernel. The software stack contains Java
applications running on top of a virtual machine. Components of the system are written in Java, C, C++, and
XML. Android operating system is a stack of software components which is roughly divided into five sections

1)
2)
3)
4)
5)

Linux kernel

Native libraries (middleware),
Android Runtime
Application Framework
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1) Linux kernel

It is the heart of android architecture that exists at the root of android architecture. Linux kernel is responsible
for device drivers, power management, memory management, device management and resource access. This
layer is the foundation of the Android Platform.
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Contains all low level drivers for various hardware components support.
Android Runtime relies on Linux Kernel for core system services like,
Memory, process management, threading etc.

Network stack

Driver model

Security and more.

2) Libraries

On top of Linux kernel there is a set of libraries including open-source Web browser engine WebKit,
well known library libc, SQLite database which is a useful repository for storage and sharing of
application data, libraries to play and record audio and video, SSL libraries responsible for Internet
security etc.
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SQLite Library used for data storage and light in terms of mobile memory footprints and task
execution.

WebKit Library mainly provides Web Browsing engine and a lot more related features.

The surface manager library is responsible for rendering windows and drawing surfaces of various
apps on the screen.

The media framework library provides media codecs for audio and video.

The OpenGl (Open Graphics Library) and SGL(Scalable Graphics Library) are the graphics
libraries for 3D and 2D rendering, respectively.

The FreeType Library is used for rendering fonts.

3) Android Runtime

In android runtime, there are core libraries and DVM (Dalvik Virtual Machine) which is responsible to
run android application. DVM is like JVM but it is optimized for mobile devices. It consumes less
memory and provides fast performance. The Dalvik VM makes use of Linux core features like memory
management and multi-threading, which is intrinsic in the Java language. The Dalvik VM enables every
Android application to run in its own process, with its own instance of the Dalvik virtual machine.

Java source e Dalvik is a specialized virtual machine designed specifically
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4) Android Framework

On the top of Native libraries and android runtime, there is android framework. Android framework
includes Android API's such as Ul (User Interface), telephony, resources, locations, Content Providers
(data) and package managers. It provides a lot of classes and interfaces for android application
development.

Activity Manager: manages the life cycle of an applications and maintains the back stack as well so
that the applications running on different processes has smooth navigations.

Package Manager: keeps track of which applications are installed in your device.



* Window Manager : Manages windows which are java programming abstractions on top of lower level
surfaces provided by surface manager.

« Telephony Managers: manages the APl which is use to build the phone applications

» Content Providers: Provide feature where one application can share the data with another application.
like phone number , address, etc

* View Manager : Buttons , Edit text , all the building blocks of Ul, event dispatching etc.
5) Applications
» On the top of android framework, there are applications. All applications such as home, contact, settings,

games, browsers are using android framework that uses android runtime and libraries. Android runtime
and native libraries are using linux kernel. Any applications that you write are located at this layer.

INSTALLING THE ANDROID SDK

For developing native Android applications that you can publish on the Google Play marketplace, you need to
install the following four applications:

 The Java Development Kit (JDK) can be downloaded from
http://oracle.com/technetwork/java/javase/downloads/index.html.
* The Eclipse IDE can be downloaded from http://www.eclipse.org/downloads/.

» The Android Platform SDK Starter Package can be download

from http://developer.android.com/sdk/index.html.

» The Android Development Tools (ADT) Plug-in can be downloaded from
http://developer.android.com/sdk/eclipse-adt.nhtml. The plug-in contains project templates and Eclipse tools that
help in creating and managing Android projects.

The Android SDK is not a full development environment and includes only the core SDK Tools, which are used
to download the rest of the SDK components. This means that after installing the Android SDK Tools, you need
to install Android platform tools and the other components required for developing Android applications. Go
to http://developer.android.com/sdk/index.html and download the package by selecting the link for your
operating system.

The first screen is a Welcome screen. Select the Next button to move to the next screen. Because the Android
SDK requires the Java SE Development Kit for its operation, it checks for the presence of JDK on your
computer.

If Java is already installed on your computer before beginning with Android SDK installation, the wizard
detects its presence and displays the version number of the JDK found on the machine, as shown in Figure.
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Java SE Development Kit
Detect whether Java SE Development Kit is installed. %

Android SDK relies on the Java SE Development Kit (JDK).
Java SE Development Kit (JDK) version 1.7 has been found

Location: C:\Program Files\Java\jdk1.7.0_04\bin\java.exe
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Figure Dialog box informing you that the JDK is already installed on the computer

Select the Next button. You get a dialog box asking you to choose the users for which Android SDK is being
installed. The following two options are displayed in the dialog box:

« Install for anyone using this computer
« Install just for me

Select the Install for anyone using this computer option and click Next. The next dialog prompts you for the
location to install the Android SDK Tools, as shown in below Figure . The dialog also displays the default
directory location for installing Android SDK Tools as C:\Program Files (x86)\Android\android-sdk, which you
can change by selecting the Browse button. Keep the default directory for installing Android SDK Tools
unchanged; then select the Next button to continue.

@ Android SDK Tools Setup =

Choose Install Location
Choose the folder in which to install Android SDK Tools. %

Setup will install Android SDK Tools in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.

Destination Folder

:\Program Files (x86) \Android\android-sdk| Browse...

Space required: 110.2MB
Space available: 118.2GB

Mullsoft Install System v12-Jul-2012.cvs
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The next dialog box asks you to specify the Start Menu folder where you want the program’s shortcuts to
appear, as shown.
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Select the Start Menu folder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder.
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Administrative Tools
Android SDK Tools
Applian Technologies
Cygwin
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Intel

Maintenance
MediaGet2
Microsoft Office

] Do not create shortcuts
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Figure: Dialog box to select the Start menu shortcut folder

A default folder name appears called Android SDK Tools. If you do not want to make a Start Menu folder,
select the Do not create shortcuts check box. Let’s create the Start Menu folder by keeping the default folder
name and selecting the Install button to begin the installation of the Android SDK Tools. After all the files have
been downloaded and installed on the computer, select the Next button. The next dialog box tells you that
the Android SDK Tools Setup Wizard is complete and the Android SDK Tools have successfully installed on

the computer. Select Finish to exit the wizard, as shown in Figure
(© Android SDK Tools Setup s [

Completing the Android SDK Tools
Setup Wizard

Android SDK Tools has been installed on your computer.

Click Finish to dose this wizard.

Start SDK Manager (to download system images, etc.)

<Back | Cancel

Figure: Successful installation of the Android SDK Tools dialog box

Note that the check box Start SDK Manager (to download system images) is checked by default. It means that
after the Finish button is clicked, the Android SDK Manager, one of the tools in the Android SDK Tools
package, will be launched. Android SDK is installed in two phases. The first phase is the installation of the
SDK, which installs the Android SDK Tools, and the second phase is installation of the Android platforms and

other components.


https://www.safaribooksonline.com/library/view/Android%E2%84%A2+Programming+Unleashed/9780133151732/ch01.html#ch01fig07

An Android application is a combination of several small components that include Java files, XML resource
and layout files, manifest files, and much more. It would be very time-consuming to create all these components
manually. So, you can use the following applications to help you:

* Eclipse IDE—An IDE that makes the task of creating Java applications easy. It provides a complete platform
for developing Java applications with compiling, debugging, and testing support.

» Android Development Tools (ADT) plug-in—A plug-in that’s added to the Eclipse IDE and automatically
creates the necessary Android files so you can concentrate on the process of application development.

Before you begin the installation of Eclipse IDE, first set the path of the JDK that you installed, as it will be
required for compiling the applications. To set the JDK path on Windows, right-click on My Computer and
select the Properties option. From the System Properties dialog box that appears, select the Advanced tab,
followed by the Environment Variables button. A dialog box, Environment Variables, pops up. In the System
variables section, double-click on the Path variable. Add the full path of the JDK (C:\Program
Files\Java\jdk1.7.0_04\bin\java.exe) to the path variable and select OK to close the windows.

CREATING ANDROID VIRTUAL DEVICES

An Android Virtual Device (AVD) represents a device configuration. There are many Android devices,
each with different configuration. To test whether the Android application is compatible with a set of Android
devices, you can create AVDs that represent their configuration. For example, you can create an AVD that
represents an Android device running version 4.1 of the SDK with a 64MB SD card. After creating AVDs, you
point the emulator to each one when developing and testing the application. AVDs are the easiest way of testing
the application with various configurations.

To create AVDs in Eclipse, select the Window, AVD Manager option. An Android Virtual Device
Manager dialog opens, as shown in Figure. The dialog box displays a list of existing AVDs, letting you create
new AVDS and manage existing AVDs. Because you haven’t yet defined an AVD, an empty list is displayed.

- Android Virtual Device Manager " R R e @M
List of existing Android Virtual Devices located at C:\Users\bintu\.android\avd
AVD Name Target Name Platform API Level CPU/ABI I New... l
No AVD available == - ‘T‘
‘-_ Delete...
| \_ Repair... ‘ l

" Details... ‘

!. Start... ‘

i v A valid Android Virtual Device. -] A repairable Android Virtual Device.
|| X An Android Virtual Device that failed to load. Click ‘Details’ to see the error.

s, = — = —— — — v

Figure: The AVD Manager dialog

Select the New button to define a new AVD. A Create new Android Virtual Device (AVD)dialog box, appears
The fields are as follows:

» Name—Used to specify the name of the AVD.

* Target—Used to specify the target API level. Our application will be tested against the specified API level.

» CPU/ABI—Determines the processor that we want to emulate on our device.
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« SD Card—Used for extending the storage capacity of the device. Large data files such as audio and video for
which the built-in flash memory is insufficient are stored on the SD card.

« Snapshot—Enable this option to avoid booting of the emulator and start it from the last saved snapshot.
Hence, this option is used to start the Android emulator quickly.

» Skin—Used for setting the screen size. Each built-in skin represents a specific screen size. You can try
multiple skins to see if your application works across different devices.

» Hardware—Used to set properties representing various optional hardware that may be present in the target
device.

In the AVD, set the Name of the AVD to demoAVD, choose Android 4.1—API Level 16 for the Target, set SD
Card to 64 MiB, and leave the Default (WVGAB800) for Skin.

In the Hardware section, three properties are already set for you depending on the selected target.
The Abstracted LCD density is set to 240; the Max VM application heap size is set to 48, and the Device RAM
size is set to 512.

You can select these properties and edit their values, delete them, and add new properties by selecting
the New button. New properties can include Abstracted LCD density, DPad support, Accelerometer, Maximum
horizontal camera pixels, Cache partition size, Audio playback support, and Track-ball support, among others.
Finally, select the Create AVD button (see Figure 1.20—right) to see how to create the virtual device
called demoAVD.

Note
You learn about the API and its different levels in Chapter 2, “Basic Widgets.” The new AVD, demoAVD, is
created and displayed in the list of existing AVDs.

Note
The larger the allocated SD Card space, the longer it takes to create the AVD. Unless it is really required,
keep the SD Card space as low as possible. I would recommend keeping this small, like 64MiB.

You now have everything ready for developing Android applications—the Android SDK, the Android platform,
the Eclipse IDE, the ADT plug-in, and an AVD for testing Android applications. You can now create your first
Android application.

Creating the First Android Project

Now let’s go over how to set up your first project so all you’ll have left to do is write! you'll start a new
Android Studio project and get to know the project workspace, including the project editor that you'll use to
code the app.

Step 1: Setup Eclipse IDE

Install the latest version of Eclipse. After successful installation, it should display a window like this:
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Step 2: Setup Android Development Tools (ADT) Plugin

Here you will learn to install the Android Development Tool plugin for Eclipse. To do this, you have to click on
Help > Software Updates > Install New Software. This will display the following dialogue box.

| Select 8 site or enter the location of a site.

Work with: - type or seiect a ste -
Find more software by working with the “Avadable Softwad

ype filter text

| Show caly the Jatest versions of available zoftware 1] Hide iterms that are already instalied
¥ Group ems by category What is glreadyioztalied?

| Show caly zaft pplicable to target
(¥ Contact all update sites duting install to find required software

@

!

Just click on the Add button as shown in the picture and add https://dl-ssl.google.com/android/eclipse/ as the
location. When you press OK, Eclipse will start to search for the required plug-in and finally it will list the
found plug-ins.
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Step 3:
After the installing ADT plugin, now tell the eclipse IDE for your android SDK location. To do so:

1.
2.

3.

4.

Step 4:
The last step is to create Android Virtual Device, which you will use to test your Android applications. To do
this, open Eclipse and Launch Android AVD Manager from options Window > AVD Manager and click on
New which will create a successful Android Virtual Device. Use the screenshot below to enter the correct

values.

You have successfully created Android Application Development environment. You are now ready to create a

Available Software
Check the iterms that you with tO snstafl

pe fiter text

Name
(7] ooi Dewetoper Tools
120 w08 NOK Plugins

Oetails

¥ Show ooty the [atest versions of svailable coftware
¥ Group merns by categony
I Show only zoftware spphicable to target onviconment
¥ Contact all update sites dusing install to find required software

Work with:  ADT Plugin - hitps//di-s3i.google.comyandrosd ecipses

Find more software by working with the “Avadisbic Softuare Stes” preferences.

Version

1 pSide iteemz that acc already instalied

What iz slccedty soatalied?

Configuring the ADT plugin

Select the Window menu > preferences

Now select the android from the left panel. Here you may see a dialog box asking if you want to send

the statistics to the google. Click proceed.

Click on the browse button and locate your SDK directory e.g. my SDK location is C:\Program

Files\Android\android-sdk .
Click the apply button then OK.

Create Android Virtual Device

Parmes AndroidPhone
Target: [Android 4.3 - APILevel 16
CPUSABE LSRN (armealbi-wT a)
SD Card:
@ Size: 16 pMIB -
Fale= B oS
Snapshot:
FEnabled
Shcim:
@) Built- @dault OO GASIOON) =
Resoluticomn: £
Hardwares
Property Valuc [ [ P—
Abstracted LOCD density 240 Delcte
Mace Wik application hea... a8 B
Device rarm size 512
Orvermid e the ewisting AVYD wath the came nammee
CTancel

|[ Create AVD j'

simple android app.
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USING THE TEXTVIEW CONTROL

In android ui or input controls are the interactive or View components which are used to design the user

interface of an application. In android we have a wide variety of Ul or input controls available, those are
TextView, EditText, Buttons, Checkbox, Progressbar, Spinners, etc.

In android, TextView is a user interface control which is used to set and display the text to the user

based on our requirements. The TextView control will act as like label control and it won’t allow users to edit
the text. A good example of TextView control usage would be to display textual labels for other controls, like
"Enter a Date:", "Enter a Name:" or "Enter a Password:".

In android, we can create a TextView control in two ways either in XML layout file or create it in

Activity file programmatically.
Specific attributes of TextView controls you will want to be aware of:

Give the TextView control a unique name using the id property.
Set the text displayed within the TextView control using the text property; programmatically set with the
setText() method.
Set the layout height and layout width properties of the control as appropriate.
Set any other attributes you desire to adjust the control’s appearance. For example, adjust the text size,
color, font or other style settings.
By default, text contents of a TextView control are left-aligned. However, you can position the text
using the gravity attribute. This setting positions your text relative to the control’s overall width and
height and only really makes sense to use if there is whitespace within the TextView control.
In XML, this property would appear within your TextView control as:
android:gravity=""center"
By default, the background of a TextView control is transparent. That is, whatever is behind the control
is shown. However, you can set the background of a control explicitly, to a color resource, or a drawable
(picture). In XML, this property would appear within your TextView control as:
android:background=""#0000ff""
By default, any text contents within a TextView control is displayed as plain text. However, by setting
one simple attribute called autoLink, all you can enable automatic detection of web, email, phone and
address information within the text. In XML, this property would appear within your TextView control
a android:autoLink=""all"
You can control the color of the text within the TextView control by using the textColor attribute. This
attribute can be set to a color resource, or a specific color by hex value. In XML, this property would
appear within your TextView control as:
android:textColor="#ff0000"
You can control the style of the text (bold, italic) and font family (sans, serif, monospace) within the
TextView control by using the textStyle and typeface attributes. In XML, these properties would appear
within your TextView control as:
android:textStyle=""bold"’
android:typeface=""monospace"

Example:
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https://www.tutlane.com/tutorial/android/android-activity-lifecycle

<TextView
android:id="@+id/message"
android:layout_width="match_parent"
android:layout_height="wrap_content"
tools:context=".HelloWorldAppActivity"
android:typeface="serif"
android:textColor="#0F0"
android:textSize="25dp"
android:textStyle="italic"
android:gravity="center_horizontal" />

This code makes the text of the Textview control appear in serif font, green color, 25dp size, italic, and at the
horizontal center of the container

USING THE ANDROID EMULATOR
The Android emulator is used for testing and debugging applications before they are loaded onto a real handset.

Android emulator is typically used for deploying apps that are developed in your IDE without actually installing
it in a device. Android emulators such as Bluestacks can run android apps where in which emulators like AVD
and genymotion are used to emulate an entire operating system. The Android emulator is integrated into Eclipse
through the ADT plug-in.
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Limitations of the Android Emulator

The Android emulator is useful to test Android applications for compatibility with devices of different

configurations. But still, it is a piece of software and not an actual device and has several limitations:
* Emulators no doubt help in knowing how an application may operate within a given environment, but they
still don’t provide the actual environment to an application. For example, an actual device has memory,
CPU, or other physical limitations that an emulator doesn’t reveal.
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* Emulators just simulate certain handset behavior. Features such as GPS, sensors, battery, power settings,
and network connectivity can be easily simulated on a computer.
* SMS messages are also simulated and do not use a real network.
* Phone calls cannot be placed or received but are simulated.
* No support for device-attached headphones is available.
* Peripherals such as camera/video capture are not fully functional.
» No USB or Bluetooth support is available.
The emulator provides some facilities too. You can use the mouse and keyboard to interact with the emulator
when it is running. For example, you can use your computer mouse to click, scroll, and drag items on the
emulator. You can also use it to simulate finger touch on the soft keyboard or a physical emulator keyboard.
You can use your computer keyboard to input text into Ul controls and to execute specific emulator commands.
Some of the most commonly used commands are
* Back [ESC button]
* Call [F3]
« End [F4]
* Volume Up [KEYPAD PLUS, Ctrl-5]
* Volume down [KEYPAD MINUS, Ctrl-F6]
* Switching orientations [KEYPAD_ 7, Ctrl-F11/KEYPAD 9, Ctrl-F12]

You can also interact with an emulator from within the DDMS tool. Eclipse IDE provides three perspectives to
work with: Java perspective, Debug perspective, and DDMS perspective. The Java perspective is the default
and the one with which you have been working up to now. You can switch between perspectives by choosing
the appropriate icon in the top-right corner of the Eclipse environment. The three perspectives are as follows:

* The Java perspective—It’s the default perspective in Eclipse where you spend most of the time. It shows the
panes where you can write code and navigate around the project.

» The Debug perspective—Enables application debugging. You can set breakpoints; step through the code;
view LogCat logging information, threads, and so on.

» The Dalvik Debug Monitor Service (DDMS) perspective—Enables you to monitor and manipulate
emulator and device status. It also provides screen capture and simulates incoming phone calls, SMS sending,
and GPS coordinates. To manage content in the device or emulator, you can use the ADB (Android Debug
Bridge).

THE ANDROID DEBUG BRIDGE(ADB)

The Android-Debug-Bridge (abbreviated as adb) is a software-interface for the android system, which can be
used to connect an android device with a computer using an USB cable or a wireless connection. It can be used
to execute commands on the phone or transfer data between the device and the computer.[1]

The tool is part of the Android SDK (Android Software Development Kit) and is located in the
subdirectory platform-tools. In previous versions of the SDK it was located in the subdirectory tools.

The Android Debug Bridge is a software interface between the device and the local computer, which allows the
direct communication of both components. This includes the possibility to transfer files from one component to
the other one, as well as executing commands from the computer on the connected device. The ADB can be
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used through a command line windows, terminal/shell in Linux-based systems, a command line (cmd) for
Windows. The main advantage is to execute commands on the phone directly out of the computer, without any
direct user interaction to the phone, which makes especially debugging a lot easier.

It is a client-server program that includes three components:

e Aclient, which sends commands. The client runs on your development machine. You can invoke a
client from a command-line terminal by issuing an adb command.

e A daemon (adbd), which runs commands on a device. The daemon runs as a background process on
each device.

e A server, which manages communication between the client and the daemon. The server runs as a
background process on your development machine.

When you start an adb client, the client first checks whether there is an adb server process already running.
If there isn't, it starts the server process. When the server starts, it binds to local TCP port 5037 and listens for
commands sent from adb clients—all adb clients use port 5037 to communicate with the adb server.

The server then sets up connections to all running devices. It locates emulators by scanning odd-numbered
ports in the range 5555 to 5585, the range used by the first 16 emulators. Where the server finds an adb daemon
(adbd), it sets up a connection to that port. Note that each emulator uses a pair of sequential ports — an even-
numbered port for console connections and an odd-numbered port for adb connections.

Once the server has set up connections to all devices, you can use adb commands to access those devices.
Because the server manages connections to devices and handles commands from multiple adb clients, you can
control any device from any client
Launching Android Applications on a Handset

To load an application onto a real handset, you need to plug a handset into your computer, using the USB data
cable. You first confirm whether the configurations for debugging your application are correct and then launch
the application as described here:

1. In Eclipse, choose the run, Debug Configurations option.

2. Select the configuration He11loWorldapp configuration, Which you created for the He1l1loWwor1dapp
application.

3. Select the Target tab, set the beployment Target Selection Mode 10 Manual. The Manual option allows
us to choose the device or AVD to connect to when using this launch configuration.

4. Apply the changes to the configuration file by clicking the app1y button.

5. Plug an Android device into your computer, using a USB cable.

6. Select run, Debug In Eclipse or press the r11 key. A dialog box appears, showing all available configurations
for running and debugging your application. The physical device(s) connected to the computer are also listed.

Double-click the running Android device. Eclipse now installs the Android application on the handset, attaches
a debugger, and runs the application.
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